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General 1

This chapter contains the following sections:

e Glossary and Acronyms

This document describes the usage of the MX-ONE Service Node (SN) packed as a Virtual Appliance for
VMware vSphere/ESXi.

If an existing MiVoice MX-ONE system has used Turnkey Solution installation (with hardware), and shall be
changed into a Virtual Appliance installation, that has to be done as a new installation with Virtual Appliance.

1.1 Glossary and Acronyms

For a complete list of abbreviations and glossary, see the description for ACRONYMS, ABBREVIATIONS
AND GLOSSARY.
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Prerequisites 2

* The vSphere Client installed on a workstation.

*  VMware ESXi 8.0 host (minimum version 5.5) or a vCenter solution, recommended version is VMware ESXi
6.7 or later shall be used.

+  The MX-ONE Service Node Virtual Appliance file.
» Good knowledge of VMware vSphere.
* Good knowledge of SLES12 and MX-ONE installation.

* Read the MiVoice MX-ONE SYSTEM PLANNING description, and the description VIRTUALIZATION FOR
MIVOICE MX-ONE 7.0 or later.

e Note:

For database (Cassandra) server VMs, co-located or stand-alone, SSD disks are required.
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Execution 3

The procedure involves the following 3 major tasks:

1. Importing the Virtual Appliance to:

* asingle ESXi host, or

» avCenter cluster
2. Post-configuring a newly imported MX-ONE virtual machine
3. Installing and Configuring MX-ONE
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Importing the Virtual Appliance 4

This chapter contains the following sections:

* Importing on a Single ESXi Host (From ESXi 6.5)
* Importing on a Single ESXi host (From ESXI 6.0 Or Earlier)
* Importing into a vCenter cluster

This section describes how to install the MX-ONE Service Node Virtual Appliance on a virtual machine.

4.1 Importing on a Single ESXi Host (From ESXi 6.5)

This section describes how to install the MX-ONE Service Node Virtual Appliance on a single VMware
ESXi host through the VMware host client. This scenario applies to the free version of ESXi.

1. Log in directly to the ESXi host through the VMware Host Client (via Web browser enter the IP address/
FQDN of the ESXi host).

2. Click Host and from the main menu, select Create/Register VM. A wizard opens that will assist in the
deployment process. in the first step, select the Creation Type and select Deploy a virtual machine from
an OVF or OVA file.

3. On the next page, specify a name for the virtual machine and select the OVF and VMDK files or the
OVA for the VM you want to deploy.

4. Select a data store for the virtual machine. It could be either local or centralized (SAN).

5. Map the networks used in this OVF to networks in your inventory, select disk format for the virtual
disks. Thick provisioning allocates all space at once, thin allocates on demand. Thick gives a slight
performance gain and eliminates the risk of over-shooting actual storage space.

6. You will get a summary page to review your settings selection before you exit the wizard and proceed to
start the deployment.

7. Click Finish to start the deployment task.

4.2 Importing on a Single ESXi host (From ESXI 6.0 Or
Earlier)

This section describes how to install the MX-ONE Service Node Virtual Appliance on a
single VMware ESXi host through the vSphere client. This scenario applies to the free

version of ESXi.

1. Log in directly to the ESXi host through the vSphere client.
2. From the File menu, select Deploy OVF Template....

3. A wizard opens that will assist you with deployment process. In the first, select the Virtual Appliance file.
Next page shows some information about the Virtual Appliance.
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Importing the Virtual Appliance

4. Specify a name and location for the deployed template.

5. Select a data store for the virtual machine. It could be either local or centralized (SAN).
6. Select thick lazy zero provisioning as the disk format for the virtual disks.

7. Map the networks used in this OVF to networks in your inventory.

8. All done - click Finish to start the deployment task.

4.3 Importing into a vCenter cluster

This section describes the import process of a MX-ONE Service Node Virtual Appliance in a VMware
vCenter cluster environment.

Such an environment contains multiple hosts, centralized storage, and distributed network and supports
the vCenter features such as vMotion, High Availability (HA), and Fault Tolerance (FT).

1. From the vSphere client or vSphere Web client, log on to the vCenter server.

2. If you are importing on a vSphere client, select from the File menu and select Deploy OVF Template....
A wizard opens that guides you through the deployment process.Select the Virtual Appliance file to
import.

3. A page opens showing information about the Virtual Appliance.

a. Select the Virtual Appliance file to import. A page opens showing information about the Virtual
Appliance.

b. Enter a name for the virtual machine, and also, select the datacenter where it should be used.

c. Select the host or cluster that should handle the new virtual machine. A review page with data about
the Virtual Appliance is displayed.

4. If you are importing on a vSphere Web client, right- click on the vCenter server and select Deploy OVF
Template.... A wizard opens that guides you through the deployment process.

a. Select the Virtual Appliance file to import.
b. Enter a name for the virtual machine, and also, select the datacenter where it must be used.
c. Select the host or cluster or resource pool or vapp where to run the new virtual machine. A review
page with data about the Virtual Appliance is displayed.
5. Select datastore for the virtual machine. Choose a centralized storage (SAN) if HA/FT will be used.

6. Select the virtual network the virtual machine must connect to. In a clustered environment, this is
normally a Distributed Switch. Be sure that switch is connected to the production/telephony network

7. Select the disk format for the virtual disks. If FT will be used, or thick provisioning must be selected. For
other cases, select any format (you can keep the default selected).

8. Select the virtual network the virtual machine must connect to. In a clustered environment, this is
normally a Distributed Switch. Be sure that switch is connected to the production/telephony network

9. With this all, necessary information is now collected. Click Finish to start the deployment task.

After you finish importing a Virtual Appliance by using a single ESXi host or a vCenter cluster, you will
have a MX-ONE Service Node in turnkey state. At this moment, the server is not yet configured and is
generic (it has not yet been assigned any specific function). Starting up the virtual machine triggers the
turnkey installation process, which is identical to the one used for physical MX-ONE servers. If more than
one MX-ONE Service Node is needed, just run the process above multiple times using the same Virtual
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Appliance file. Give each virtual machine an unique name and distribute them over the hosts in the cluster
(how depends on the cluster setup, the amount of servers inside the cluster and the load on the hosts)



Post-Configuration of a Newly 5
Imported MX-ONE VM

Before using a newly imported MX-ONE virtual server, some settings must be considered and maybe changed.
These are mainly related to processor and memory allocation

* Hardware - Memory

The amount of memory the virtual machine is equipped with. The value must be changed according to the
system size and the MX-ONE application that the server will run, e.g. Service Node, Service Node Manager,
Database (Cassandra), Provisioning Manager and Media Server. For configuration and planning of virtualization,
see the description VIRTUALIZATION FOR MIVOICE MX-ONE 7.0 or later.

« Hardware - CPU

By default, two CPUs are allocated to the virtual machine. If you plan to use Fault Tolerance together with the
MX-ONE Service Node, this must be changed up to 8 vCPUs. Also, numbers of CPUs needed in a server
depends on desired performance and system size. For configuration and planning of virtualization, see the
description VIRTUALIZATION FOR MIVOICE MX-ONE 7.0 or later.

* Options - Paravirtualization

This must be disabled on Fault Tolerance-enabled virtual machines as it is not supported. On all other
configurations, keep this enabled.

¢ Resources - CPU

This setting affects the resource allocation in the cluster/host. This must be configured to match required
performance of the MX-ONE and the capacity of the cluster/host and how many virtual machines are running in
parallel.

* Resources - Memory

As for the CPU-resources, this setting depends on the capacity needed, the cluster/host configuration and how
many other virtual machines are running in parallel.

* Disks

For database (Cassandra) server VMs co-located or stand-alone, SSD disks are required.
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e Note:

Be sure that the network configuration of the virtual machines is properly set up in the cluster. By default,
the standard "VM Network" is used. In a cluster environment where distributed switches are used (a
requirement if HA/FT is used), this must certainly be changed.



Installing MX-ONE on Hyper-V 6

The Microsoft hardware virtualization product, Hyper-V lets you create and run a software version of a computer,
called a virtual machine. Each virtual machine acts like a complete computer, running an operating system and
programs. The following are the requirements of the virtual machine.

* It can be installed on Windows Server (2019, 2016)

» It requires only a Windows license and no specific license is required.

*  Windows Server can be installed on a Dell or an HP server.lt is similar to VMware in its functioning.
* It uses .vhd and. vhdx format image for installation.

To install MX-ONE on a Hyper-V setup:

Once the Windows Server get successfully installed,
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1. Enable Hyper-V using PowerShell.

a. Open a PowerShell console as Administrator.
b. Run Enabl e- W ndowsOpt i onal Feature -Online -FeatureNanme M crosoft-Hyper-V -All

command to install Hyper-

EX Administrator: Windows PowerShell

yft Corporation. A1l rights reserved.

Enable-wind

V.

alFeature

t-Hyper-V

Installing MX-ONE on Hyper-V

c. Or you can open the service manager - Add role and features and install Hyper-V.

1=

Server Manager * Dashboa

= Dashboard WELCOME TO SERVER MANAGER

i Local Server

i' All Servers . .

- o Configure this local server
BE File and Storage Services b -

B Hyper-v QUICK START

& Add Roles and Features Wizard

Select server roles

Select one or more roles to install on the selected server.

Roles

O

[] Active Directory Domain Services

[ Active Directory Federation Services

[] Active Directory Lightweight Directory Services
[] Active Directory Rights Management Services
[[] Device Health Attestation

[] DHCP Server

] DN Server

] Fax Server

[®] File and Storage Services (1 of 12 installed)
[] Host Guardian Service

/| Hyper-V (Installed)

[ MultiPoint Services

[ Network Policy and Access Services

[] Print and Document Services

[] Remote Access

[ Remote Desktop Services

[] Volume Activation Services

] web Server (II5)

[ Windows Deployment Services

DESTIMATION SERVER
WIN-35MLITLAMDG

Description

Active Directory Cerfificate Services
(AD C5) is used to create
certification authorities and related
role services that allow you to issue
and manage certificates used in @
variety of applications.

i All Servers 1

Manageability
Events

I Services
Performance

BPA results

1/29/2019 1:23 AM
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Installing MX-ONE on Hyper-V

iz Server Manager

Server Manager » Dashboard

Dashboard WELCOME TO SERVER MANAGER

Local Server

HE Al . .

o8 A e ﬂ Configure this local server
& File and Storage Services b

B8 Hyper-v QUICK START

Add roles and features

N

Add other servers to manage

WEATE AW 4 Create a server group

Connect this server to cloud services

LEARN MORE

ROLES AND SERVER GROUPS

Roles: 2 | Server groups: 1 | Servers total: 1

g File and Storage

. 1
Services

B Hyper-v 1

@ Manageability

® Manageability

Wi Al servers 1
® Manageability @® Manageability

58 Hyper-V Manager - 8 x
File Action View Help

e 2m B

B Fyper-V Manager — ‘Actions
- wal Machines
i WIN-35MLITLAMDG — WIN-3SMLITLAMDG -
Neme State CPUUsage  Assigned Memory  Uptime Status Configurati. . R
No vitual machines were found ontis server

% Import Virtual Machine...
7] Hyper- Settings.
22 Virtual Switch Manager...
4 Virtual SAN Manager...
o EditDisk
2 Inspect Disk...
®) Stop Senvce
X Remove Server
© Refresh

View »
Help

2. Before you install, create a Virtual Switch Manager for Hyper-V to give network access to the virtual
machines.

3. Select Virtual Switch Manager from the right

[ Hyper-V Manager b X
Fie Action View Help
|25 Hm

B Hyper-V Mansger — e
B WIN-3SMLITLAMDG ines LA =
Name State CPUUsage  Assigned Memory  Uptime Stotus Configurati » R

No vitua machins werefound on i sever. B Import Vitusl Machine...

] Hyper-V Settings
2 Virtusl Svitch Manager..
4. Virtual SAN Manager..
& EditDisk
£ Inspect Disk.
&) Stop Senice
X Remove Server
© Refresh
View »

Help
pane
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Installing MX-ONE on Hyper-V

4. Select the type of switch, in this case, an External

FI o
Fle Acion View Hep

e a5 EE

BB Hyper-V Manager

WIN3SMLITLAMDG | Vietual Macines e
B v WIN-3SMLITLAMDG
Neme State CPUUsage  AssignedMemory  Uptime Status Configurati.. .
No vitual machines wer found on th server. % import Virtus Machine.
2 Virtual Switch Manager for WIN-3SMLITLAMDG - X [2] Hyper-V settings.
2 Virtual Switch Manager,
A Virtual Switches = 4 Virtual SAN Manager.
i 4 EditDisk
2 Inspect Disk..
e %) stopenice
00 t0 0015 X Remove Server
© Refresh
Create VetualSwitch View
Creates a virtual sitch that binds to the physical network adapter 5o that virtual Help
can access a physical network.
[checkpoiats o
Switch [Detais
FLEY: Janag 5
File Acion View Help
e zm Bm
FF Hyper-V Menager . “Actions
B WIN-3SMLITLAMDG Virtual Machines ]
Neme State CPUUsage  Assigned Memory  Uptime, Status Configurat,
New »
No vitual machines were found onthis server. %, import Vitual Machine..
512 Vitual Switch Manager for WIN-3SMLITLAMDG - X [£] Hyper-V settings.
58 Vitual Switch Manager..
5 4 Virtual SAN Manager.
= New virtual network switch
CES e & Edit Disk..
ctcrene GsitEte... | [Newvetualwich ] D Inspect Disk...
L Mew Virtual Switch
Broadcom NetXtreme Gigabit .. | Notes: &) Stop Service
2 Global Hietwork Settings X Remove Server
015502 U Refresh
View »
Comection type
What do youwant to connect this vt swich to? Hep
© External network:
Sroadcom NetXreme Ggabit Ehernet v
(%]
] Enable snge-oot 10 vitualzaton (SR-10Y)
O Internal network
O Private network
(] Enable virtual LAN dentfication for management operating sytem
2
Remove
@ SR10V can oy be confgured when the irtual swich i reated. An extermal
vitual itch with SR-10V enabled cannot be converted to an nternal or prvate =
Checkpoints. Sitch, ©
Apply ‘Wk I == =
L& Network Connections - m] x
+ .E' » Control Panel » Metwork and Internet » Metwork Connections v O Search Metwork Connections @
Organize * Disable this network device Diagnose this connection Rename this connection Wiew status of this connection Change settings of this connection B:~ m 0
MICT - MIC2 vEthernet (Broadcom MetXtreme
) Py - .
Enabled Network cable unplugged Gigabit Ethernet - Virtual Switch)

@7 Broadcom Netitreme Gigabit Eth.. 3§ @27 Broadcom NetXtreme Gigabit Eth... @7 Network 2

Connections.
7. Create a virtual instance.
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Installing MX-ONE on Hyper-V

8. Select New > Virtual

4 Hyper-V Manager - 8 X
File Action View Help
= 2w Bm

Hyper-V Manager [ “Actions
B e | [t o
New Virtuel Machine... PUUsage  Assigned Memory  Uptime Status Configurati
Import Virtual Machine... Hard Disk... New >
yper Setings Floppy Disk No vitual machines were found o this sever. % mport Vitus! Machine,
Virtual Switch Manager... [] Hyper-V Settings...
Virtual SAN Manager.. 8 Virtual Switch Manager.
Edit Dk L Vitual SAN Manager..
Inspect Disk.. 4 EditDisk.
e & Inspect Disk..
Remove Server ) Stop Service
Refresh X Remove Server
View > © Refresh
View >
Hel
E ‘H Hep
B Hyper ¥ Manage .
File Action View Help
e a5 EE
[ Hyper-V Manager - . Actions
i WIN-3SMLTLAMDG Mgoliactioc R
Name State CPUUsage  Assigned Memory  Uptime Status Configurat . R
No vitual mactines werefound onthis server. B, ImportVitual Machine..
[ 2] Hyper-V Settings..
H2 Virtual Switch Manager...
4n. Vitual SAN Manager.
3 New Virtusl Machine Wizard x & EditDisk..
£ Inspect Disk.
(®) Stop Senvice
@ Specify Name and Location
X Remove Server
© Refresh
egn 3 View »
ofy Name an X g Heo
fy this workoad. g
Assgn Memory Name:  [Vocone-Livl
o 1
< folder, four
Instaltion Optons 0] Store the vitual machine ina dfferentlocation
Summary CProgranbata Microsoft\Windons yper 4\
<Previous Fineh Cancel
Next —
18 Hyper: - o
File Action View Help
e 25 BE
[ Hyper-V Manager Actons
Fi WIN-3SMLITLAMDG Vitusl Machines >
Neme State CPUUsage  Assigned Memory  Uptime Status Configurat..
New »
No vitual machines werefound on s sever. mpert Vil Machine.
Hyper-V Settings..
Virtual Switch Manager...
. Virtal SAN Manager.
3 New Virtual Machine Wizard x it Disk
S Inspect Disk.
Stop Service
L] Assign Memory y
Remove Server
Refresh
Before You Beon Specfy the amor y View »
VB though 12582912 V.
B Hep
FoschComsta] Startup memory: e
2
se Dynamic Memary for tis virtual machine.
Confiure Networking L v
() assion to
Instalaton Optons
Summary

<Prevon | [l
Next. Credgoms
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11. Select the Network Switch which you have configured initially and click

I
File Action View Help

= | 2| B

Installing MX-ONE on Hyper-V

i —— =
e I T .

No vitual machines were found on this server.

W New Virtual Machine Wizard

@ configure Networking

virtualswitch, o it can remain discomected.

‘Specify Generation
e
S

Summary.

Connecton: [Not Connected
I

= B

N ext . Checkpoints.
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Installing MX-ONE on Hyper-V

12. Select the image (VHD) by selecting the option, Use an existing virtual Hard disk and select the location

where your VHD image is stored (In case of MX-ONE Unzip the Hyper-V Image and select the Virtual Hard
Disk ).

B& Hyper-v g
File Action View Help

& »m i

[ Hyper-V Manager . -
[l WIN-35MLITLAMDG e
Name State CPUUsage  Assigned Memory  Uptime Status Configurati..
No vitual machines were found on this server.
EH New Virtual Machine Wizard X
=] ‘Connect Virtual Hard Disk
Before You Begin A virtual machine requires storage so that you can install an operating system. You can specify the
S storage now or configure it later by modifying the virtual machine’s properties
Specify Generation O create a virtual hard disk
sssign Memory Use this option to create a VHDX dynamically expanding virtual hard disk.
Configure Networking MX-ONE-LIML.vhdx
(:\Jsers Publicipocuments Fiyper Vitel Hord Disks\ Bramee
Summary B
Size: 127 GB (Maximum: 64 TB)
@® Use an existing virtual hard disk
Use this option to attach an existing virtual hard disk, either VHD or VHDX format.
Location: [FEEINROTSUNETELE NE_7. 1.5p0 b ci0 vhor I
© Attach a virtual hard disk later
Use this option to skip this step now and attach an existing virtual hard disk ater.
< Previous Finish Cancel
PES—
B8 Hyper-V Manage
File Action View Help
e #E B
[ Hyper-V Manager - .
s WIN-35MLITLAMDG VI SRS
Name State CPUUsage  Assigned Memory  Uptime Status Configurati...
No virtual machines were found on ths server
3 Open x
« “ 4 » ThisPC > Desktop > HyperV-Image-MX-ONE 7.1.sp0.nf0rel0 > Virtual Hard Disks v & | Search Virtual Hard Disks )
Organize v New folder =~ I @
Name Date modified Type Size
s Quick access
B Deskiop | = MXONET1p0iDrc10 17 AM  Hard Disk Image F... 12,161,024 ..
¥ Downloads ~ #
[ Documents  #
&) Pictures *
Virtual hard disks
[& Microsoft Managem:
[ This PC
“i Local Disk (C)
1 Network
File name: | MX-ONE_7.1.5p0.hf0.re10 || Virtual hard disk iles v
Checkooints
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B8 Hyper-V Manager
File Action View Help

e znm

Installing MX-ONE on Hyper-V

S Hyper-V Manager
[l WIN-35MLITLAMDG

13. Change system

Virtual Machines
Name State CPUUsage  Assigned b zmory  Uptime Status Configurati...
Ne vitual machines were found on this server.
3 New Virtual Machine Wizard 4
=] Completing the New Virtual Machine Wizard
Before You Begin u have successfully completed the New Virtual Machine Wizard. You are about to create the
following virtual machine.
Spedify Name and Location
Specify Generation e
Assign Memory Name: MY-ONELITML
ST Generation: Generation 1
Memory: 8000 MG
Connect Virtual Hard Disk Metwork:  Broadcom NetXireme Gigabit Ethernet - Virtual Switch
Hard Disk: ~ C:\Jsers\Adminisirator \Desktop HyperV-Image-M¥-ONE _7. 1.5p0 hfi.rc 10Wirtual Hard
< >
To create the virtual machine and dose the izard, dick Finish,
<Previous Next > Finish Cancel
[P——
B8 Hyper-V Manager
File Action View Help
e | z@ B
[ Hyper-V Manager
[l WIN-QSLOSK123JT R
Name State CPUUsage  Assigned Memory  Uptime Status Configurati...
B wxoNeLMT Running 0% 2000 MB 00:01:06 80
) Settings for MX-ONE-LIM1 on WIN-QSLOSK123JT - X
MX-ONE-LIM1 ~ o
£ _Hardware ~ | B AddHardware
B 5105 You can use this setting to add devices to your virtual machine
Boot from CD Select the devices you want to add and cick the Add button.
@ searity SCal Controller
Key Storage Drive disabled Network Adepter
W Memory RemoteFy 30 Video Adapter
sooome Leqacy Netwark Adapter
[ Processor Fibre Channel Adapter
Virtual processor
=) [ IDE Controller 0 Add
. Hard Drive
Checkpoints (
&l 551 Controller
I Network Adapter
New Virtual Switch
§ com1
None
§ com2
None
[ Diskette Drive
None
A Management
Name
MX-ONE-LIM 1
[ 1ntegration Services
Some services offerd
{1, Checkpoints
Production
@ Smart Paging File Location
C:ProgramData MicosoftWiin...
}"’“’""“"‘ conce ot
—— s e e

settings.

28/1531-ANF 901 14 Uen F

Service Node Virtual Appliance - Installation Instructions




Installing MX-ONE on Hyper-V

14. Start the machine and install MX-ONE setup as shown in the following figures.

H
File Action View Help
& =| #mE B
5 Hyper-V Manager

EE WIN-35MLI7LAMDG

File Action View Help
= 75 BEF

B Hyper-V Manager
i WiN-QoLOsK1aa)T| e Action Media Clipboard View Help

D@0 |n |k
H¥-ONE Telephony System Setup, Uersion:7.1.8.0.1

5 X-ONE-LIMT on WIN-35MLITLAMDG - Virtual Machine Connection - o X

File Action Media Clipboard View Help
Virtual Mal (5 =@ O | n IR

GNU GRUB version 2.02

P4
Advanced options for SLES 12-SP4

Use the T and ! keys to select which emtry is highlighted.
Press enter to boot the selected 0S, ‘e’ to edit the commands
‘before booting or ‘c’ for a command-line.

The highlighted entry will be exccuted automatically in 3s.

Status: Running =0

Configurati
80

Actions
WIN-35MLITLAMDG
New
% Import Virtual Mc
7 Hyper-V Settings
5 Virtual Switch Me
Virtual SAN Manc
& EditDisk.
L Inspeet Disk.
) Stop Service
X Remove Server
© Refresh
View
H Hep
MX-ONE-LIMT
98 Connect..
[7 Settings...
) Tum Off..
® Shut Down.

0O save

B MXONE on WIN-QSLOSK123T - Virtusl Machine Cannection

MX-ONE Initial Setup

Welcone to MX-ONE Telephony System Setup

You have to configure your server before starting

the Telephony Systen.

Do you vant to configure your server mou?

<o >

28/1531-ANF 901 14 Uen F

Service Node Virtual Appliance - Installation Instructions



File Action View Help

== | x5 HEF
B Hyper-V Manager
B WiN-QaLOsK1oarT| Fie Action Media Clipboard View Help

=5 @O |n Ik

£ MXONE on WIN-QSLOSK123)T - Virtual Machine Connection

MX-ONE Initial Setup
Successful restart of network
service

Missing servers will not be included if you choose to continue
They can be added later

Uait for expected server(s) to appear
Mew server data file(s) received from:
mxone-linl.nitel.con

[Press ¢ to continue

Status: Runring

File Action View Help

L RN 7 iy

1 MXONE on WIN-QILOSK123IT - Virtual Machine Connection -
[E Hyper-V Manager
i WIN-QOLOSK123yT| ile Action Media  Clipboard  View  Help
D@0 n

1011 nxone-linl.mitel.con

[Executing:
fcassandra_sn createTables, schema file=coptseri_sn/1?.1.0.0.1/etc mxone_cql.schena
ok

[Executing:
| opt /mxone_instal1,7.1.0.0. 1 target~install_scriptssserviceNode “insertConfigDataInDB’
Inserting Alarn Configuration into database...
Inserting default domain data into database.
ok

Executing “start” in all servers

Ack fron mone-1linl.mitel.com
uait for 1 ansuers.

Answer received from:

1011 mxone-1iml.mitel.con
pistribute server data to other servers
ok
ait for LING) to start

IMax wait time: 11 minutes
status InitialStartOfSysten occured

fconf ig_nirror ok
WHHHEHE R SRR R RN
"

# OBSERVE!? To get correct group membership logout and in again. &

# #
AR R R R R R R R

Installing addon softuare
Installing MX-ONE Service Node Mamager - please wait ...

starting silent installation of mxome_snm rpm
[Follou progress by opening another shell and typ
ail £ - B svar-log mxone uebserver appl ication_log. log

fcreated synlink from setcssystend systemsmulti-user . target .uants/mxone_jboss.service to susrs1ib/systend systensmione_jboss .service.
Installation of MX-ONE Service Node Manager is finished.
ucbserver will now be re-started. This may take a while.
Sce progress in:
~opt~ jboss-standalone log server . log
IFinished. See log file /var,log/mxone uebserver/application_log. log for details.
Updat ing serverData.conf

Installation finished successfully

Actions
WIN-QILOSKIZ3IT
New
% Import Virtual Machine.
Hyper-V Settings.
2 Virtual Switch Manager.
Virtual SAN Manager

s EditDisk.,

& Inspect Disk...
u) Stop Senvice
X Remove Server
U Refresh
View
H rer
MXONE
48 Connect.
[y Settings.
) TumOF.
@ shutDown.
O save
1 Pause
1> Reset
[ Checkpoint
B Move
1 Export.
<] Rename.
B Enable Replication...

H Hep
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To install MX-ONE on the Kernel-based Virtual Machine (KVM) on the SuSE Linux platform, follow these steps:

. Download the MX-ONE ISO image (Recovery image) from the MX-ONE repository.

. Make a bootable USB and load it with the Recovery image to install OS with KVM capability.
. Run the USB and select option 3 (KVM install).

. Install the KVM image and system is restored with SUSE Linux installed.

. Enter the root login credentials.

a b WON =

6. Using the Yast utility, enter IP address, Gateway, DNS and subnet Mask to the system. For more information
see, https://www.suse.com/documentation/sled11/book_sle _admin/index.html?page=/documentation/sled11/

book_sle_admin/data/sec_basicnet_yast.html.
P

199999999999999999999999999TIIAIIIIIIIIIIIIIIIIIIIIIIAAE 1q

7. Using the configured IP address login to the terminal using putty.
8. For the installation of KVM over SUSE download the. gcow2 and .xml files from the package repository.
9. Check if | i bvi rt d is running or not, else start it: sudo systencttl status libvirtd

libvirtd.service - Virtualization daenon Loaded: | oaded (/usr/lib/

systend/systenf|libvirtd. service; enabl ed; vendor preset: enabl ed) Acti ve:
active (running) since Mon 2019-04-08 14: 38: 40 CEST; 22h ago Docs:
man: | i bvirtd(8) https://libvirt.org Main PID: 21036 (libvirtd)
Tasks: 18 (limt: 32768) CG oup: /systemslicel/libvirtd.service
??21036 /usr/sbin/libvirtd -1isten
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Installing MX-ONE KVM, SuSE Linux

10. Create a virtual machine, entervirt-cl one --original -xm Virtual _I mage- MX-
ONE_7.0.sp0. hf2.rc5.xm --name <your system nanme> --file /local/inmages/<your
syst em name>. gcow?2

For example,virt-clone --original-xm Virtual | nmage- MX-ONE 7. 1. sp0. hf0. rc26. xnl
nane MX-ONE --file /1l ocal / MX-ONE. qcow2

e Note:

Keep the gcow2 and xml under the local folder. Edit (vi) the xml file and change the default path from /

kvm/images to /local where you have saved the image file.

11. When the kvm image installation is complete, create a network bridge and map it to the et h0 that you are

using so that KVM can access it.
12. To add a new network bridge device on VM Host Server with br ct | , follow these steps:

a. Log in as root on the VM Host Server where you want to create a new network bridge.

b. Choose a name for the new bridge-VIRBR_TEST in our example- and runr oot # brctl addbr
VI RBR_TEST.

c. Check if the bridge was created on VM Host Server r oot # brctl show

bri dge nane bridge id STP enabl ed interfaces br0
8000. e06995ec09e8 no ethO virbroO
8000. 525400b37ec9 yes Virbr0O-nic virbr_test

8000. 000000000000 no

o Note:

Vi rbr _test is listed, but not associated with any physical network interface

d. Add a network interface to the bridge usingroot # brctl addif VI RBR TEST et hl command.

e Note:

Network interface must not be already in use. This is because you can only enslave a network
interface that is not yet used by other network bridge.

e. Optionally, enable STP usingroot # brctl stp VI RBR_TEST on command.

For more information, see https://www.suse.com/documentation/sles-12/book_virt/data/
libvirt_networks_bridged.html.

brctl showbri dge nane bridge id STP enabl ed
i nterfacesbrO 8000. 28b9d9e09f 41 no et ho
vnet 0

13. To start your virtual machine, install Mobaxterm (GUI or X server support). See https://
mobaxterm.mobatek.net/download-home-edition.html
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14. Run KVM machine and run vi r t - manager on the command line.

B root@linux-2drwi~

Terminal  Sessions  View  Xs

ver Tools Games Settings Macros Help

L R 2 & & 0
Sessin Severs  Tods  Games Semsons  Vew | St Mitbiec Tumeng Padoses Setings b

[7]3-root@linux-2drwc~

P e |
Reconnect SSH-browser

A
P
ol

3
>

Sessions

& Tools

nstsys
bash.history ¢
vininfo .

Xauthority

X Macros

15.
KVM and install it.

8 Virtual Machine Manager@lnus-2drw
Fle Edt View Help

B open a -

~ QEMUrKVM

W8 MX-ONE on QEMU/KVM@linux-2drw
Fle Virtual Machine View Send key

" "
# OBSERVE?! To get correct group membership logout and in again. #
W W

R R R R,
Installing addon sof tuare
Installing MX-ONE Service Node Manager - please wait ...

Starting silent installation of mxome_snm rpn
Follow progress by opening another shell and &
il -f -n 8 /var‘/lugrmxune/uehserver/mpplmatmn log. log
Created synlink from setc-systend systenmulti-user. target .uants/mxone_jboss.service to susr-1ib/systend systen/mxone_jboss .serv
ice.
Installation of MX-ONE Service Node Manmager is finished.
Webserver will now be re-started. This nay take a while.
See progress in:
opt/ jboss/standalone-log server . log
Finished. See log file varslog/mxome uebserver application_log.log for details.
Updating serverData.conf

Installation finished successfully

Linux-On8y:~ # bretl show
If ’brct]” is not a typo you can use conmand-not-found to lookup the package that contains it, like this:
conf brctl

Linux-Bn8y:~ # ifconfig -a
etho Link encap:Ethernet Haddr 52:54:00:47:F8:29

inet addr:10.211.91.34 Bcast:10.211.91.255 Mask:

inet6 addr: fedd::5054:ff :fed? :1629-64 Scope:Link

UP TROADGAST RURNING HULTICAST HIU:1500 Metric:1

RX packets:4158 errors:0 dropped:1967 overruns g

TX packete: 147 orroreid dropped 0 ouerrune:0 sarrion 0

collisions:0 txqueuelen: 1008
FX butes 338960 (331.0 Kb) TX bytesiZ357 (2.9 Kb)

Link encapzLocal Lnnpback

frane:0
carrier:0
collisions:0 txgueuelen:1000

RX bytes:15399832 (14.6 Mb) TX bytes:15399032 (14.6 Mb)

Linwc-0nBy:~ #

16. Executables are stored in/ usr/ | i bexe.

X

X O

Xserver  Exit

9

This gives you the virtual manager access through which you, start, stop, or change the MX-ONE deployed



Installing MX-ONE KVM on Redhat-
Linux

To install Kernel-based Virtual Machine (KVM) on Redhat-Linux, follow these steps:

1. Install the Redhat-7.6 OS through a bootable pen-drive or any other external media.
2. Create a bridge interface; for example, i f cf g- br 0.

0 Note:

For configuration details, see Network Bridge.

3. Copy the MX- ONE . gcow? image to the host machine to continue installation. See Creating a VM by
Importing an MX-ONE gcow?2 Image on page 22 for installation instructions.

Creating a VM by Importing an MX-ONE qcow2 Image

To create a virtual machine (VM) by importing an MX- ONE qcow? image, follow these steps:

1. Log in to your machine as root user.
2. Navigate to the directory of the installation files previously downloaded.

e Note:

Create a backup copy of the image file.

3. Move the image file to the directory where you want to place the virtual machine.

4. i

Start the Virtual Manager and click Create a new virtual machine =
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Installing MX-ONE KVM on Redhat-Linux

5. Select Import existing disk image and click Forward. See Create a new virtual machine screen for details.

Figure 1: Create a new virtual machine screen

m Create a new virtual machine

Connection: QEMU/KVM

Choose how you would like to install the operating system
Local install media (ISO image or COROM)
Network Install (HTTP, FTP, or NFS)
Network Boot (PXE)
e) Import existing disk image

w Architecture options

Architecture: | x86_64 »

Cancel Back Forward

6. Click Browse and navigate to the path of the image file.

7. Select the image file and select the operating system type and version from the following fields and click
Forward. See Selecting the OS and version for details.

* OS type
¢ Version

m Create a new virtual machine

Provide the existing storage path:

| flocalfimages/new_machine.qcow2 Browse...

Choose an operating system type and version

0S type: | Linux -
\ersion: | SUSE Linux Enterprise ¢ | «
Cancel : ‘ Back | Forward

Figure 2: Selecting the OS and version
8. Complete the following fields and click Forward (see Memory and CPU settings for details):

*  Memory (RAM)
« CPUs
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e Note:

For the memory and CPU settings, specify values that match your system. For the purposes of this
procedure, the values 6 GB RAM (6144 MB) and 2 CPUs are specified.

Figure 3: Memory and CPU settings

m Create a new virtual machine

Choose Memory and CPU settings

Memory (RAM): | 144 = |l ‘

Up to 96255 MIB available on the host
CPUSs: | 7| & |

Up to 12 available

Cancel Back Forward
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9. Click Finish. See Creating a VM for details.

The details of the VM to be created are displayed.

Figure 4: Creating a VM

Ready to begin the installation

Name: | new_maching|

0S: SUSE Linux Enterprise Server 12 SP4
Install: Import existing OS image
Memory: 6144 MiB
CPUs: 2
Storage: /local/images/new_machine.qcow2

Iz Customize configuration before install

» Network selection

Cancel ‘ Back Finish

10. Click Begin Installation. The virtual machine is created. See Begin Installation for details.

Figure 5: Begin Installation

</ Begin Installation @ Cancel installation

{3 CPUs MNarme: new_machine ‘

&5 Memory uuID: 5b8a0ad2-ag3b-41c8-baBe-5e56bf8c2533

gi} Boot Options Status: B shutoff (Shut Down)

_ Virtlo Disk 1

=V 2 Title: ‘

B NIC :80:02:3d -
Description:

!I Tablet
! Display Spice

HF Sound ich6

G'G Console Hypervisor Details

= Channel gemu-ga Hypervisor: KVM

£~ Channel spice Architecture: x86_64

B video oxL Emulator: fusr/bin/gemu-kvm

= Firmware:

MF Controller USB 0 ‘ BIOS =
) USB Redirector 1 i ] 7

@ i Chipset ‘ e ‘

@ USB Redirector 2
gi} RNG jdevjurandom
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11. Use the Mobaxterm (GUI or X server support). to open a virtual manager session. See Virtual Machine
Manager for details.

Figure 6: Virtual Machine Manager

[}
b

¥ Virtual Machine Manager@localhost.localdomain = O X

File Edit View Help

II-I B Open n -
Name v CPU usage
v QEMU/KVM

MXONE-KVM-REDHAT
Running |



Installing and Configuring MX-ONE 9

With all the virtual MX-ONE servers in place and configured, it is time to build a PBX out of them. The procedure
of setting up the system is the same as for physical MX-ONE servers loaded with turnkey installations. The
difference lays in the access of the MX-ONE servers that is done through the vSphere client.

For more details see INSTALLING AND CONFIGURING MIVOICE MX-ONE.
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